
It ’s mid-year and it looks like the re-runs have already 
started… But it’s not true though!  SumProduct celebrates that two of its gang retain their MVP status and we celebrate with the 
announcement of an old favourite: Excel Virtually Global!  And to keep the “Oldies But Goodies” theme, we even revisit one of Excel’s least understood 
functions, AGGREGATE.

This month, we also include all the usual newsletter goodies such as the Beat the Boredom Challenge, Charts & Dashboards, 
Visual Basics, Power Pivot Principles, Power Query Pointers, Excel Updates, literally the Deduce our A to Z of Keyboard 
Shortcuts and LOG the A to Z of Excel functions.  

As always, happy reading and remember: stay safe, stay happy, stay healthy.
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SumProduct is pleased to announce that two of our Directors, Liam 
Bastick and Tim Heng, have been re-awarded Microsoft’s Most Valuable 
Professional (MVP) award for Excel for 2023-24.  Not unluckily for 
Liam, he receives his 13th award, whilst Tim forges ahead with his sixth.  
This award recognises exceptional technical community leaders from 
around the world who voluntarily share their high quality, real world 
expertise with others.  Microsoft MVPs are a highly select group of 
experts representing technology's best and brightest who share a deep 
commitment to community and a willingness to help others.

Worldwide, there are over 100 million participants in technical 
communities; of these participants, there are c.4,000 active Microsoft 

MVPs.  In Excel, we believe there are approximately 80 that have 
received this award. 

Microsoft’s MVP Award evaluates technical expertise and voluntary 
community contributions for the past year, considering the quality, 
quantity and level of impact of contributions.  It’s a difficult award to 
attain and just as difficult to retain. 

At SumProduct, you can rely on our experience and willingness to help - 
simply drop us a line at contact@sumproduct.com.  

MVP Renewal
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We don’t have all the details yet – but it’s time to make an announcement 
it’s “coming soon”!!

The MVPs and other experts are back to passionately share their 
knowledge with the community.  They are always on the “bleeding 
edge” and have an unstoppable urge to get their hands on new, exciting 
technologies.  

How much would you be prepared to pay for the likes of Excel (and 
other) MVPs, Microsoft staff and other industry experts to present on a 
variety of Excel topics in your house?

Well, it’s an option.  For the fourth year running, we are remaining virtual 
(maybe next year…).  And it still remains for charity.

This virtual conference presents Excel, Data Platform and PowerPoint 
MVPs and other experts, together with other acknowledged experts 
from Microsoft and / or around the globe to present, answer questions 
and demonstrate the future of Excel and how it will make your life easier, 
personally and professionally.  And it’s a big year this year, with Excel, 
ChatGPT, Fabric, Copilot, Power Apps and financial modelling in Power 
BI all staking their claims in the modelling world.

Topics and presenters have not yet been agreed, but you know the 
drill!  We’ll round a few up and get them to entertain you.  Dates will 

be announced SOON, but we anticipate sessions to begin in the week 
commencing Monday 9 October 2023.

Each session (including Q&A) will last no more than an hour and topics 
cover all expertise levels, from novice to expert.  Most presenters are 
well known in their spheres, and have written blogs, books and articles 
and / or present video sessions.

Most sessions will be recorded so you may watch them later with 
downloads aplenty – there are no medals for staying up to watch the entire 
event live!  That’s just as well, as we plan to beat last year’s marathon  
(no guarantees), which lasted the best part of two [2] days.  

From your own favourite chair, bring a laptop, an inquisitive mind and 
your sense of humour.  Be prepared to learn heaps.  And remember, it’s 
not just value for money, we will be asking for donations to charity this 
time around – all profits will be donated to a global COVID-19 research 
charity.

More details will be available in the News section of our website soon: 
www.sumproduct.com/news.

Hopefully, we’ll see you there!

Excel Virtually Global 2023

AGGREGATE() first appeared in Excel 2010.  And ever since, it has caused constant consternation amongst the modelling fraternity.  Never mind 
ChatGPT, LET and LAMBDA, some of the most common questions we get here at SumProduct HQ emanate from the wonderful AGGREGATE function.  
Therefore, we thought we would revisit it this month, as it often seems so neglected.

For those who desire greater sesquipedalian loquaciousness (look it up!), its syntax may give some comfort as it has two forms:

	 •	 Reference: =AGGREGATE(function_number, options, ref1, [ref2],…)

	 •	 Array: =AGGREGATE(function_number, options, array, [optional_argument])

where:

	 •	 function_number denotes function that you wish to use.  Similar to SUBTOTAL,  function_number allocates integer values to various 	
		  Excel functions:

AGGREGATE: Possibly the most complicated Excel function ever..?
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	 •	 options specifies which values may be ignored when applying the chosen function to the range.  If the options parameter is omitted, the 	
		  AGGREGATE function assumes that options is set to zero [0].  The argument options can take any of the following values:

	 •	 ref1 is the first numeric argument for the function when using the reference syntax

	 •	 ref2,... is optional.  Numerical arguments may number two [2] through 253 for the function when using the reference syntax

	 •	 avrray is an array, array formula or reference to a range of cells when using the array syntax

	 •	 optional_argument is a second argument required if using the LARGE, SMALL, PERCENTILE.INC, QUARTILE.INC, PERCENTILE.EXC or 	
		  QUARTILE.EXC when using the array syntax, viz. 

AGGREGATE is analogous to an extension of the SUBTOTAL function 
insofar that it uses the same function_number arguments, simply 
adding another eight [8].  SUBTOTAL allows users to use the 11 functions 
including / excluding hidden rows which results in 22 combinations.  
AGGREGATE goes further and takes the 19 functions and allows for eight 

alternatives for each, which results in 152 combinations – and that’s not 
even considering the reference or array syntax approaches!

It just all sounds, well, tremendously complicated.  
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In practice, it’s not that bad.  This is because since this function was created for Excel 2010 and later, screen tips will appear as you type in order to 
nudge you in the right direction.  For example, let’s say you wanted the third largest number in the following list:

From inspection, the third largest value is the amount in cell A2 (the value ‘5’), but if you use the usual formula for this =LARGE(A2:A10,3) you will 
get the value #REF! as this is the first error that Excel comes across as it works down the list.

This is where you can use AGGREGATE() to ignore these errors.  If you type in =AGGREGATE( you will get the following screen tip scroll list:

By typing ‘14’ or selecting ’14 – LARGE’ from the pop-up list, you now know you are on the right track.  After typing a ‘comma’, Excel then continues 
to help you:
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Again by either typing a number or pointing and clicking an appropriate choice may be made.  I want to ignore errors, so I need to choose ‘2’, ‘3’, ‘6’ 
or ‘7’, depending upon what else should be ignored.  I will choose ‘6’ – ignore error values only and then type another comma so that the screen tips 
keep coming thick and fast:

Now, Excel is seeking the references for evaluation.  It appears to be possible that this can be in the form of a list (the array) or else discrete cell 
references and / or values.  In this example, I will enter the range and type another comma:

Now, Excel appears to be looking for the other argument for LARGE() or else another reference.  This is not correct.  The screen tip does not update 
automatically.  The syntax required is now just as it would if we had typed in the underlying function, i.e. =LARGE(array, k).  In this instance, this 
syntax always requires the fourth value to be k, the integer denoting the kth largest item in the list.  

In this example, I will just type the value ‘3’ and close brackets.  Therefore, we arrive at the following formula,

=AGGREGATE(14, 6, A2:A10, 3)

which generates the correct answer ‘5’.  The formula might look counterintuitive, but Excel has helped us every step of the way.  As my oft-misquoted 
English teacher always used to say, practice makes prefect.

This month’s challenge involves automating the generation of multiple worksheets from a data list.  For example, we have a data list that contains 
the names of the worksheets that we are going to create, as shown below:

Like SUBTOTAL, the AGGREGATE function is designed for columns 
of data (vertical ranges), not for rows of data (horizontal ranges). For 
example, when you subtotal a horizontal range using option one [1], 
such as AGGREGATE(1, 1, ref1), hiding a column does not affect the 
aggregate sum value, although hiding a row in vertical range does affect 
the aggregate.

If a second ref argument is required but not provided, AGGREGATE 
returns an #VALUE! error.  If one or more of the references are three-
dimensional references, AGGREGATE returns the #VALUE! error value.

Word to the wise

With many of us currently “working from home” / quarantined, there 
are only so Zoom / Teams calls and virtual parties you can make 
before you reach your (data) limit.  Perhaps they should measure data 
allowance in blood pressure millimetres of mercury (mmHg).  To try and 

keep our readers engaged, we will continue to reproduce some of our 
popular Final Friday Fix challenges from yesteryear in this and upcoming 
newsletters.  One suggested solution may be found later in this newsletter.   
Here’s this month’s…

Beat the Boredom Challenge
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We need to create multiple worksheets with the names shown in the data list above, so that the result will look like this:

We want to automate this process without manually adding each worksheet and changing the worksheet name individually.  A job for VBA, perhaps..?

Sounds easy?  Try it.  One solution just might be found later in this newsletter – but no reading ahead!  

It’s time to chart our progress with an introductory series into the world of creating charts and dashboards in Excel.  This month, we discuss dashboard 
design [nice alliteration – Ed.].

The key to a good dashboard / report is creating one that is tailored to the end users, so that it fulfils all their needs.  For example, there is no point 
for a sales team to be bombarded with other information that they go not need to do their job, such as:

	 •	 depreciation analysis
	 •	 debt / equity ratios
	 •	 budget variances in costs
	 •	 segmental margins analysis,

if it isn’t relevant.

The same point goes for all other staff, so that they have more time to focus on doing their job, be it to order more stock or provide analytical reports.  
That’s not to say this data is not essential to management, but a key idea in developing your narrative is determining your audience.

Therefore, we need to be able to identify who they are and what we think they will need to see.   When identifying our target audience, we should 
consider the following:

	 •	 Granularity: how detailed the data has to be for them to do their job
	 •	 Level of information required: what sort of information do they need to accomplish their goal? (high level overview or more detailed?)
	 •	 Timescale: how much data do they need to achieve their task
	 •	 Leading and lagging metrics: are historical metrics sufficient or are projections required as well?
	 •	 Decision making required: which decisions they must make after looking at the data.

For instance, sales teams and lower management probably need to see day to day inventory stock and day to day customer traffic amounts, e.g.

	 •	 Granularity: high granularity of data
	 •	 Level of information: very low
	 •	 Timescale: short 
	 •	 Leading and lagging metrics: historical data and short-term projections
	 •	 Decision making required: stock ordering, economic order quantities. 

Meanwhile, manager level staff will probably need to see monthly, or even quarterly, sales and inventory stock amounts for their reports:

	 •	 Granularity: medium
	 •	 Level of information: overview of sales performance
	 •	 Timescale: medium 
	 •	 Leading and lagging metrics: this is more likely to be summary (lagging) data, concentrating on historical results
	 •	 Decision making required: resource management and reporting issues to higher management.

Senior level management will want to see quarterly, or even yearly data:

	 •	 Granularity: low
	 •	 Level of information: overview of key metrics
	 •	 Timescale: long
	 •	 Leading and lagging metrics: historical summary with possibly a high-level projection
	 •	 Decision making required: supply chain solutions, staff performance management, reporting to top level management, restructure of  
		  branches, project approval, areas of improvement.

Top level management will want to see annual data and forecasts:

	 •	 Granularity: very low
	 •	 Level of information: high overview of key metrics
	 •	 Timescale: very long
	 •	 Leading and lagging metrics: historical summary, with possibly a high-level projection
	 •	 Decision making required: company direction, areas to grow the company, areas for company to pull out from, company investments.
	 •	 Timescale: very long
	 •	 Leading and lagging metrics: historical summary, with possibly a high-level projection
	 •	 Decision making required: company direction, areas to grow the company, areas for company to pull out from, company investments.

Charts and Dashboards

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

Other dashboard design considerations include which types of charts, how to use colour to your advantage and how to create memorable charts.

Now, we will consider an example of a bad and a good dashboard.  For example, a manager is requesting to see metrics of their income.  They also 
want to see some insights of the sales breakdown and performance in a financial year.  

A “bad dashboard” might look like this:

Look at it.  It has many colours, but it is not eye-catching:

	 •	 the charts are not organised
	 •	 the charts are not relevant to the end users
	 •	 the charts contain too much information, more than 7 + 2
	 •	 the information provided on the charts does not really help the end users  
	 •	 the dashboard has arguably a terrible use of colour
	 •	 axes make results and comparisons difficult
	 •	 good point: the dashboard does actually depict seasonal trends.

Compared to the example bad dashboard, the below dashboard is enhanced:

Key things to note from this dashboard:

	 •	 a harmonious colour scheme is used
	 •	 key metrics pop out to the user: All important information can be found in five seconds
	 •	 the charts are organised
	 •	 the appropriate charts have been selected to display the respective data
	 •	 the dashboard displays seasonal trends.

More next month…
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We thought we’d run an elementary series going through the rudiments of Visual Basic for Applications (VBA) as a springboard for newer users.   
This month we go back to basics with the first in a continuing series.

Visual Basics

VBA (Visual Basic for Applications) is a programming language developed 
by Microsoft and is built into Excel and other Office programs.  It enables 
building your own functions (known as User Defined Functions or UDFs 
for short), automating processes and interacting with libraries to work 
with the Windows operating system.  It is also used to write some of the 
custom add-ins for Office applications.

In Office for Mac, VBA was upgraded in 2016 but some features and 
certain commands do not function correctly and herein lies the problem: 
it doesn’t work everywhere – but lots of people use it as a readily 
accessible porthole for Microsoft Office and often Excel in particular.

You can’t say “VBA” without talking about macros.  A macro is simply 
a sequence of actions that can be executed together, written in VBA.  
Office applications (apart from PowerPoint) allow the “recording of 

macros” where every single step performed is recorded and translated 
to Visual Basic code.  After recording / writing a macro, these bits of code 
can be reused to automate these actions.

This is all well and good, but macros are disabled by default in the Office 
applications.  This is because VBA scripts may be automatically executed 
whenever a spreadsheet is opened – and that’s not good given all those 
nasty people out there.  Some scripts can be malicious and cause issues 
on your machine.  For example, some VBA scripts can delete files and 
your Outlook email address book.

To change the security settings for macros, these may be accessed in 
‘Excel Options’ (ALT + T + O) in the ‘Trust Center’ group in the resulting 
left-hand column of the dialog box.  Once there, click on the ‘Trust Center 
Settings…’ button, viz.

Under the ‘Macro Settings’ group, a set of options is presented:
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Excel defaults to ‘Disable all macros with notification’.  This means that whenever a workbook has a macro (only .xls, .xlsb and .xlsm files may have 
macros) a pop-up warning window will appear before opening a file:

This is a little confusing for older users of Excel as the default is similar to Excel 2003, even if the setting starts with ‘Disable’.  It’s not the only thing 
you have to do, mind you.

To fully utilise VBA in Excel, you need to have access to the ‘Developer’ tab, which shows the VBA tools available.  By default, the Developer tab of 
the Ribbon is not made visible.  To enable this as well, right-click on the Ribbon and select ‘Customize the Ribbon…’:

The ‘Excel Options’ menu will pop up.  On the right-hand side, you’ll see “Customize the Ribbon” where you can click which tabs are to be visible.  
Click on the check box next to ‘Developer’ and select ‘OK’.

Then we’ll see the ‘Developer’ tab on the screen. 

You’re good to go!

More next month.
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We continue our series on the Excel COM add-in, Power Pivot.  This month, we consider how to include filters in the MAXX function.

Power Pivot Principles

Last newsletter we covered how the MAXX functions works.  This time, we’d like to expand on the MAXX function a little and show you how we may 
use other functions that return with a table to alter the MAXX function’s results. 

For this example, let’s look at the following Table (the capitalisation is deliberate): 

As a quick refresher, the following measure calculates the greatest amount spent on apples:

=MAXX(
	 'AppleSalesCustType',
		  'AppleSalesCustType'[Price] * AppleSalesCustType[Purchase Volume]
	 )

This measure returns with the value of $690.00, which is the greatest amount spent on apples without any filters. 

What we did not cover last time is that the MAXX function can work with other functions too.  For instance, we may use the FILTER function to filter 
out customers that do not fulfil the criterion ‘Customer Type’ = 1.

=MAXX(
	 FILTER(
		  'AppleSalesCustType',[Customer Type]=1
		  ),
			   'AppleSalesCustType'[Price] * AppleSalesCustType[Purchase Volume]
	 )
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The FILTER function returns with a table (quoting the MAXX syntax from last time).  Therefore, we are able to use these two functions together.  
Exporting this to a PivotTable yields the following result:

The greatest amount spent on apples by customers who fall into the ‘1’ category is $480.00.

That’s it for this month; more next time.  
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Each month we’ll reproduce one of our articles on Power Query (Excel 2010 and 2013) / Get & Transform (Office 365, Excel 2016 and 2019) from  
www.sumproduct.com/blog.  If you wish to read more in the meantime, simply check out our Blog section each Wednesday.  This month, we look at 
some useful logical M functions which convert data into dates or vice versa.

Power Query Pointers

To conclude our series on dates, let’s take a look at some functions that we may use to convert a date into a different data type.  For example, one 
such data type would be text, so that we may use a date as part of a reference.  We will also look at functions that perform the opposite process, 
converting dates into text.

Date.FromText(date as nullable text, optional culture as nullable text) 
as nullable date

This returns a date value from text (date) in a recognised date format 
according to the culture, following the ISO 8601 format standard.

It’s probably helpful to know what formats would be accepted here.  
For en-US culture, text in the form yyyy-MM-dd is accepted, as is 
yyyyMMdd and M/d/yyyy.  Cultures such as the UK and Australia prefer 

to put the day before the month, so it helps to know the windows culture 
being used: this may be specified in any of the formulas we are looking 
at today.   

As an illustration, we have some data from our fictional sales person, 
John.  He has decided to embed the date in a column and we need to 
extract it and convert it into data type date so that we may link the data 
to other tables.

The current Expense Type is a text field that contains the date.  We want to extract the date part of the text column and convert it to a date.   
We’ll begin by extracting the date using the ‘Extract’ option in the ‘From Text’ section on the ‘Add Column’ tab.

Date.FromText
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We could now just convert this to a date by using the Transform menu, but instead we will enter the formula directly to create a new custom column.

The M formula used is

= Date.FromText([First Characters])
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The date has been converted correctly.  But why would we ever need to use a formula instead of just using a transformation?  Suppose we had the 
next dataset coming in…

Well that doesn’t look good.  We need to alter the Expense Date formula.  We will add a new column that will tell Power Query to use en-US culture, 
as John has clearly used US date formatting.

The formula used is:

= Date.FromText([First Characters], "en-US")

The date has been calculated correctly because we have specified the culture used.

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

Date.ToText(date  as nullable date, optional  format  as nullable text, 
optionalculture as nullable text) as nullable text

This returns a textual representation of date.  This function takes in an 
optional format parameter.  

The full list of formats that are supported are supposedly in the Microsoft 

help pages, but Lord Lucan is a little easier to find; we’ll give a couple of 
examples in the exercise that follows.

We may use this M function to format dates ready to add them to a 
reference or to display them in a required format for a report.  We will 
format Correct Expense Date in a couple of ways to show how this 
function can be used.

The M formula used is

= Date.ToText([Correct Expense Date], ddd-MMM-yyyy", "en-US")

We have to mention the culture because the date is held using the US date format.

Now we will use a shorter form.

Date.ToText
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The M formula used is

= Date.ToText([Correct Expense Date], "ddd", "en-US")

This gives an idea of the range of different texts that may be produced.

Date.From(value as any, optional culture as nullable text) as nullable date  

This returns a date value from a value.

Similar to Date.FromText(), the main advantage that this function has over the standard menu option of transforming a number to a date, is that it 
can specify the culture.  Below, a column has been inserted that contains the expense date in a numeric format:

Date.From
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We add a new column where the number is converted to a date.

The M formula used is

=Date.From([Date as Number])

The date is shown in its proper format for our system.
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Date.ToRecord(date as date) as record

This returns a record containing parts of a date value.

This is more for the techies amongst us, as it will create a record containing the year, month and day as entries.  We will do this for Correct Expense Date.

The M formula used is

= Date.ToRecord([Correct Expense Date])

We can see the records and what is in them by expanding the Data Record column:

This is a nice way to extract the year, month and day all in one move.

More next time.

Date.ToRecord
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It seems a little quieter this month – not surprising given how much we reported in last month’s newsletter!  Nevertheless, let’s get you up to date.  
The full list is as follows:

Reporting

	 •	 Smoothed and Leader lines – updates

	 •	 On-Object Interaction – updates in Preview:

	 	 	 ○	 Customise the Pane Switcher

	 	 	 ○	 CTRL Click to open multiple panes in the Pane Switcher

	 	 	 ○	 Treemap sub-selections now supported

	 	 	 ○	 Noteworthy bug fixes

Modelling

	 •	 Edit your Data Model into the Power BI Service – updates in 	
	 	 Preview:

	 	 	 ○	 Relationship validation

Data connectivity

	 •	 Google Analytics (connector update) 

	 •	 Oracle Database (connector update) 

	 •	 Azure Databricks / Databricks (connector update) 

	 •	 Denodo (connector update) 

	 •	 EQuIS (connector update) 

	 •	 Anaplan (connector update)

Service

	 •	 Dataset details page revamp

Mobile

	 •	 Datasets are coming to Power BI Mobile Apps

Developers

	 •	 Boost your Custom Visuals performance

Visualisations

	 •	 New visuals in AppSource

	 •	 Elevate Your Map Charts with Drill Down Map PRO 

	 •	 “All-in-one” Multi Target KPI card

Other

	 •	 WebView2 now Generally Available.

Let’s look at each in turn.

Power BI Updates

Report creators may now create smoother line and area charts, providing a more polished look to their visualisations.  To access this setting, go to 
Lines -> Shape -> Line Type:

Power BI has recently added leader lines for both line and area charts.  This new feature creates a visual connection between each data point and its 
corresponding label.  To access this feature, simply navigate to the Data labels -> Options -> Leader lines.

Smoothed and Leader lines – updates
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Apparently, these features are just the beginning of several improvements coming soon for graphs, charts, plots and markers.

The new On-Object Interaction feature was released in Preview back in March.  This month sees more improvements and bug fixes.

You can also access the two [2] preference settings released in last month’s update to ‘Always show the Pane Switcher’ and re-attach the Build menu 
as a pane by using the gear icon.

Power BI has now added a new ‘+’ button on the Pane Switcher to quickly 
add new panes directly from the Pane Switcher without having to go to 
the View tab on the Ribbon.  This menu also provides you with a brief 

description of what panes are available and what their functions are.  
Furthermore, the panes added to the Pane Switcher are saved across 
reports.  Therefore, you only need to set configurations once.

On-Object Interaction – updates in Preview

CUSTOMISE THE PANE SWITCHER
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In addition to the right-click option ‘Open in new pane’, it is now even easier to open multiple panes from the Pane Switcher by simply holding down 
the CTRL key and Clicking the pane you wish to open.

As demonstrated below:

These include:

	 •	 overlap of the On-Object buttons on the Formula bar has finally been resolved

	 •	 the visual ToolTip shows when opening the Build menu automatically, blocking the Formatting On-Object button is now fixed

	 •	 selected visual type is now reflected in the Ribbon visual gallery accordingly

	 •	 the mini-toolbar’s fill colour icon now reflects conditional formatting gradient as well.

Microsoft is adding relationship validation into the Service, making it easier to create and edit relationships on the web.  Like Power BI Desktop, as you 
define the properties of your relationship, the system will automatically validate it and offer appropriate choices for cardinality and cross filter selections.

The Google Analytics connector has been updated to support Google Analytics Data API (Google Analytics 4).  To use this new functionality, use 
‘Implementation 2.0’ when connecting.  Existing connections will not be affected.

The Oracle connector has been updated to enable Azure AD-based Single Sign-On functionality through the on-premises data gateway.  This will 
require the July release of the on-premises data gateway.

The Azure Databricks and Databricks connectors have been updated.  The following amendments have been made:

	 •	 added a new DSRHandler to databricks-multicloud

	 •	 fixed C_NOT_ENABLED and Catalog ‘spark’ not found’ error in legacy code path using Databricks.Contents.

Data Model editing in the Power BI Service feature was released in Preview back in April.  Microsoft has made one improvement this month…

CTRL CLICK TO OPEN MULTIPLE PANES IN THE PANE SWITCHER

TREEMAP SUB-SELECTIONS NOW SUPPORTED

NOTEWORTHY BUG FIXES

RELATIONSHIP VALIDATION

Google Analytics (connector update) 

Oracle Database (connector update) 

Azure Databricks / Databricks (connector update) 

Edit your Data Model into the Power BI Service – updates in Preview
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This new version adds graphical support for the specification of native SQL queries at data source creation time.

The EQuIS connector has been updated.  The following adjustments have been made:

	 •	 removed ‘Beta’ attribute

	 •	 retrieved report content as .csv to remove the row limitation of .xlsx files
	 •	 optimised handling of facility groups in the Navigation tree

	 •	 now show report and / or location folders in Navigation tree, even if one or the other is empty.

This version of the Power BI connector for Anaplan includes backend changes for compatibility with ongoing Anaplan infrastructure updates.  
However, there is no change to user facing connector features.

Now, when you click on a dataset item in the OneLake data hub and workspace view, you will be directed to the redesigned page that not only 
enhances the look and feel but also introduces new capabilities for an improved user experience.

Here’s what you can expect to find on the dataset details page:

	 •	 Actions: you will find various actions that can be performed on the dataset, such as creating a report and refreshing the dataset.  With 	
		  this release, there is now the option to view the Refresh history under the Refresh menu

	 •	 Dataset Metadata: gain insights into the dataset through its description and last refresh time

	 •	 Related Items: explore existing related items associated with the dataset

	 •	 Dataset Schema: obtain a comprehensive view of the dataset’s tables and columns.  Clicking on a table provides a table preview, with 	
		  export capabilities available using paginated reports behind the scenes.

Additionally, there are now significant improvements to the related items list.  It now showcases all the downstream and upstream dependencies 
for the dataset.  This enhancement allows you to easily identify the sources of the dataset, composite model relations, reports and dashboards 
associated with it.

In the next Power BI Mobile App release, Microsoft is adding a long-
waited feature that will help dataset owners and report creators to 
manage their dataset directly from their phone.  That means you will 
be able to see in your mobile device datasets.  Go to a workspace, make 
sure to select the ‘dataset’” pill at the top and get the list of datasets that 
you have access to in that workspace.

When tapping on a dataset, you will get the dataset metadata pane, 

which includes the name, owner, sensitivity label and also the latest 
refresh status.  From this pane you may also trigger a dataset refresh all 
directly from your mobile application.

Dataset owners will also get push notifications when the scheduled 
refresh fails.  They will be able to view the failure details and be able to 
re-try the refresh while they are on-the-go.

Denodo (connector update) 

EQuIS (connector update)

Anaplan (connector update)

Dataset details page revamp

Datasets are coming to Power BI Mobile Apps
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Microsoft has announced techniques to improve the performance of 
custom visuals, discussing the performance improvements made in both 
visual rendering and load times.  They have identified and addressed 
certain bottlenecks in the code, and these improvements are available 
for any visual that has been updated to API version 4.2 and onwards.  
Along with these fixes, Microsoft has also provided code practices and 
techniques that can greatly enhance the performance of rendering 
custom visuals.  It is recognised that getting the visual to render as 
quickly as possible is critical when writing the code.

Having said all this, as the Power BI platform continues to be improved 
and enhanced, new versions of the API will constantly be released.  In 
order to get the most out of the Power BI visuals' platform and feature 
set, it is recommended that you keep up-to-date with the most recent 
version.  To find out which version you’re using, check the aversion in 
the pbiviz.json file.

In the meantime, here are some recommendations for achieving optimal 
performance for your custom visual.

A smaller custom visual plugin size results in:

	 •	 faster download times

	 •	 faster installation whenever the visual is run.

Measure the render time of your visual in various situations to see which, if any, parts of the script require optimisation.

	 •	 first render of the visual	 	 	 	

	 •	 thousands of data points

	 •	 a single data point / measure (to determine the 	
	 	 visual render overhead)

	 •	 filtering

	 •	 slicing

	 •	 resizing (this may not work in the Performance Analcczer).

Boost your Custom Visuals performance

REDUCE PLUGIN SIZE

CHECK RENDER TIME OF THE VISUAL

POWER BI DESKTOP PERFORMANCE ANALYZER

Use the Power BI Desktop Performance Analyzer (sic) (View -> Performance Analyzer) to check how your visual renders in the following cases:

If possible, compare these measurements with those of a similar core visual to see if there are parts that may be optimised.
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Use the User Timing API to measure your app's JavaScript performance.  This API can also help you decide which parts of the script need optimisation.

When you update the visual:

	 •	 don't re-render the entire visual if only some elements have changed.  Render only the necessary elements

	 •	 store the data view passed on update.  Render only the data points that are different from the previous data view.  If they haven't  
		  changed, there's no need to re-render them

	 •	 resizing is often done automatically by the browser and doesn't require an update to the visual.

When a node or list of nodes is retrieved from the DOM (Data Object Model), think about whether you can reuse them in later computations 
(sometimes even the next loop iteration).  As long as you don't need to add or delete more nodes in the relevant area, caching them can improve 
the application's overall efficiency.

To make sure that your code is fast and doesn’t slow down the browser, keep DOM access to a minimum.  For example, instead of:

Limit DOM manipulations as much as possible.  Insert operations like prepend(), append() and after() are time-consuming and should only be used 
when necessary.  For example, instead of:

JavaScript

public update(options: VisualUpdateOptions) { 

    let axis = $(".axis"); 

}

try:

JavaScript

public constructor(options: VisualConstructorOptions) { 

    this.$root = $(options.element); 

    this.xAxis = this.$root.find(".xAxis"); 

} 

public update(options: VisualUpdateOptions) { 

    let axis = this.axis; 

}

There are various ways to test you custom visual:

	 •	 code instrumentation: use the following console third party tools to gather data about your custom visual's performance:

			   ○	 console.log()

			   ○	 console.dir()

			   ○	 console.time()

			   ○	 console.timeEnd()

	 •	 the following web developer tools may also help measure your visual's performance, but keep in mind that they profile Power BI as well:

			   ○	 Metrics

			   ○	 JavaScript profiler.

Once you determined which parts of your visual need optimisation, you can then implement these further tips.

USE THE USER TIMING API

UPDATE MESSAGES

CACHE DOM NODES

AVOID DOM MANIPULATION

OTHER WAYS TO TEST YOUR CUSTOM VISUAL
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JavaScript

for (let i=0; i<1000; i++) { 

    $('#list').append('<li>'+i+'</li>');

}

try making the above example faster by using html() and building the list beforehand:

JavaScript

let list = ''; 

for (let i=0; i<1000; i++) { 

    list += '<li>'+i+'</li>'; 

} 

$('#list').html(list); 

Limit JS frameworks and use native JS whenever possible to increase the available bandwidth and lower your processing overhead.  Doing this might 
also decrease compatibility issues with older browsers.

For repeated use of animations, consider using Canvas or WebGL instead of SVG.  Unlike SVG, with these options, performance is determined by size 
rather than content.

You should read up on third party sites for tips on improving canvas performance, such as”

	 •	 faster load times

	 •	 improving HTML5 Canvas performance

	 •	 optimising canvas generally.

Use requestAnimationFrame to update your on-screen animations, so your animation functions are called before the browser calls another repaint.

Does the animation loop redraw unchanged elements?  If so, it wastes 
time drawing elements that don’t change from frame-to-frame.  Instead, 
you should update the frames selectively.

When you're animating static visualisations, it’s tempting to lump all 
the draw code into one update function and repeatedly call it with new 

data for each iteration of the animation loop.  Instead, consider using a 
visual constructor method to draw everything static.  Then, the update 
function only needs to draw visualisation elements that change.

In particular, Microsoft has noted that inefficient animation loops are 
often found in axes and legends.

	 •	 Text size calculation: when there are a lot of data points, don't waste time calculating text size for each point.  Calculate a few points and 	
	 	 then estimate

	 •	 If some elements of the visual aren't seen in the display, there's not need to render them.

Yet another raft for this month:

	 •	 Spider Chart for Power BI by VisioChart

	 •	 HTML Content (Lite)

	 •	 Stacked Lipstick Bar Chart (Standard)

	 •	 Stacked Lipstick Column Chart (Standard)

	 •	 100% Stacked Column Chart with Values instead of % 	
	 	 (Standard)

	 •	 Dual Axis Scatter Chart (Standard)

	 •	 Category Comparison Bar Chart

	 •	 Stacked Column with Percentage and Total in Label (Standard)

	 •	 Likert Scale Chart for Power BI by ChartExpo.

RECONSIDER JQUERY

ANIMATION OPTIONS

CANVAS PERFORMANCE TIPS

ANIMATION FUNCTIONS

ANIMATION LOOPS

Common issues

New visuals in AppSource
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Drill Down Map PRO by ZoomCharts is a custom map visual for Power BI that lets you show your data on an interactive map and give it location-
based context.

Features include:

	 •	 built-in shape layers: use preset shapes for easy filtering of countries
	 •	 custom shape layer support: provide custom shapes through KML and GeoJSON files

	 •	 lasso tool: draw and save your own filter shapes on top of the map

	 •	 node clustering capabilities: clusters can be turned into Do(ugh)nut or Pie charts for category display
	 •	 map base layer: lets you choose from four [4] options:

			   ○	 Azure maps

			   ○	 Custom (OpenStreetMaps, Google, CartoDB etc.)
			   ○	 Image (e.g. floor plans)
			   ○	 None (visualise shapes without a background)

	 •	 aura, image and custom label support.

Popular use cases:

	 •	 production: monitoring production data by location

	 •	 sales and marketing: mapping sales results by region

	 •	 public sector: visualising environmental and sociodemographic data.\

The Multi Target KPI card works with a single query and includes three 
additional indications, multiple categories, a pixel perfect alignment 
setting and built-in conditional formatting.  You can change the settings 
of layout type and colour conditional formatting for additional measures 
in the visual and it is fairly simple for non-designers to use too.

Simply select the desired measure and category, if necessary.  Add up to 
three [3] additional indicators to provide the context you need for your 
metric.  It will help you improve reporting performance and save you 
time when designing and developing supplemental measures.

Elevate Your Map Charts with Drill Down Map PRO 

“All-in-one” Multi Target KPI card
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WebView2 is now Generally Available.  I think we might have said that in the heading..?

More next month!

WebView2 now Generally Available

The latest updates saw quite a few highlights.  There is ‘Formula Suggestions’ and ‘Formula by Example’ for Excel web users.  ‘Use Image’ and Data 
Types in PivotTables are now available for Windows and Mac Insider users, and ‘Generate an Accessible PDF’ is available to all Mac users.

You can check out the full list here:

Excel for the web

	 •	 Formula Suggestions

	 •	 Formula by Example

	 •	 Support Chart Formatting via Selection and Ribbon Buttons

	 •	 Move Chart Elements within Chart Player

	 •	 Name Manager

Excel for Windows

	 •	 Office Scripts (Current Channel and Monthly Enterprise 	
	 	 Channel)

	 •	 Get data from Dynamic Arrays (Current Channel)

	 •	 Rapid Refresh (Current Channel)

	 •	 Guided Reapply (Current Channel)

	 •	 Use Image and Data Types in PivotTables (Insiders)

	 •	 Data Validation Dropdown List Autocomplete (Current 	
	 	 Channel)

	 •	 Paste Values directly into your workbook using a Keyboard 	
	 	 Shortcut (Current Channel)

New Features for Excel
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Excel for Mac

	 •	 Generate an Accessible PDF 

	 •	 Enhanced Search Experience 

	 •	 Use Image and Data Types in PivotTables (Insiders).

Let’s get started.

Back in December last year, Microsoft announced ‘Formula Suggestions’ 
was beginning to roll out to Excel web users.  Now, it is available to 
all web users with English set as their primary language (rules me out 
then: I use profane).  Whether you’re new to Excel or have used it for 
years, ‘Formula Suggestions’ helps you create formulae more quickly 
and accurately by offering relevant suggestions based on your data and 
context.  All you need to do is type "=" at the beginning of a cell, and 

Formula Suggestions will show you different formulae that you can apply 
to your data, along with a specified range.     

‘Formula Suggestions’ can help you in several ways.  First, it can improve 
your productivity by reducing the time and effort you need to type and 
edit formulae.  For example, look at how Formula Suggestions suggests 
a simple summation here:  

Second, ‘Formula Suggestions’ can provide you with robust formulas 
that will not break if you alter your data as it automatically adjusts the 
ranges to match your data structure.  For example, totals are affected 

when you add a new row to a table.  If you use Formula Suggestions, 
the range will automatically update to include the new row, but if you 
manually add the cells, it will not – as in the following example:

Formula Suggestions
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Here, in cell D14, I have typed in the rather dreadful formula 

=D5+D6+D7+D8+D9+D10+D11+D12+D13

However, in cell I14, I have started to type the formula in to prompt ‘Formula Suggestions’ and then used the formula recommended.  This gives 
similar calculations:

This will clearly give a better row should team members be added (rows inserted) or removed (rows deleted).

Third, ‘Formula Suggestions’ can help you discover new possibilities of what you can do with your data, by showing you different formulae that are 
relevant for your analysis.  Whether you are a beginner or an expert in Excel, ‘Formula Suggestions’ can offer you a convenient and intuitive way to 
create formulae.  ‘Formula Suggestions’ can suggest the following aggregation formulae: 

	 •	 SUM 
	 •	 MIN
	 •	 MAX 
	 •	 AVERAGE 
	 •	 COUNT 
	 •	 COUNTA

These formulae are widely used in Excel to perform various calculations 
and analyses on data, such as finding the sum, minimum, maximum, 
average or count of values in a range. 

For example, ‘Formula Suggestions’ may also assist in cell-counting tasks.  
The COUNT formula counts cells that contain numbers, whilst COUNTA 
will count all non-empty cells regardless of the type of data they contain.  
Using the correct formula is crucial to get the correct results, and this 
may be achieved by leveraging ‘Formula Suggestions’ ability to predict 
the correct formula for each of the use cases.

Formula Suggestions currently provides suggestions for basic aggregation 
formulae, helping users who are not yet acquainted with these Excel 
formulae.  However, experienced users may benefit greatly from this 
feature as well, as it suggests not only the appropriate formula but also 
the appropriate range for that formula.  The range suggestions can save 
a great deal of time, and can also prevent us from selecting incorrect 
ranges, which may lead to wrong results.  

At the time of this article, Formula Suggestions is available to Excel web 
users that have English set as their primary language.

Last month, ‘Formula by Example’ started to roll out to Excel web users.  ‘Formula by Example’ looks for patterns as the user enters data in the 
worksheet.  When it recognises a pattern, ‘Formula by Example’ offers a formula to fill the rest of the column with the recognised pattern.  

Consider ‘Formula by Example’ helping to reverse the first and last name order here, where we start typing in what we want:

Formula by Example
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At this stage, ‘Formula by Example’ interrupts us:

 We can click on ‘Show Formula’:

All you have to do now is ‘Apply’:
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It’s Flash Fill with formulae (more on that later)!

Currently, ‘Formula by Example’ supports Excel tables.  Support for 
ranges is coming in a future release.  In the meantime, if you wish to 
try ‘Formula by Example’ on a range of data today, convert it into a 
table (select range and click Insert -> Table or use the CTRL + L keyboard 
shortcut – CTRL + T does not work in Excel for the web).

Once you have a "CTRL + L" Table, ‘Formula by Example’ suggestions will 
appear after you provide Excel with a few examples in a certain column.   

Excel scans the column to identify a pattern in your data.  When it finds 
a pattern, Excel will show a suggestion.

Formula by Example can recognise several patterns like text 
transformations, date transformations, arithmetic calculations, row 
numbering and forward filling.  It’s pretty simple:

‘Formula by Example’ will identify if you are trying to perform an arithmetic operation on different columns.  Let’s say we want to find the total sales by 
multiplying the Price by Quantity.  By typing the first couple of results, Excel can complete the rest of the column with the arithmetic calculation formula:
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You can also use ‘Formula by Example’ to apply different types of rounding to your numbers.

‘Formula by Example’ allows you to create a dynamic row numbers column from example.  This could come in handy in cases where you’d want your 
numbering to dynamically adjust if you add or remove a row.

You can also use Formula by Example to forward fill the rest of the column based on the first examples.

At the time of writing, ‘Formula by Example’ is available on Excel web 
for all US English users of OneDrive for Microsoft 365 Personal or Family.  
‘Formula by Example’ is rolling out to users of SharePoint and OneDrive for 
Business.  Additional language support will be available in a future release.

It should be noted that filling column data based upon a pattern is 
something that Excel has been able to do for many years, using a feature 
called Flash Fill.  However, Flash Fill’s suggestions are only provided as 
static text.  If you wanted to change some of your input data or reuse the 
suggestion on different cells, you wouldn’t be able to do so, because you 
wouldn’t get a formula as an output.  With ‘Formula by Example’, you will 
now see a formula that you can easily change, copy and reuse anywhere 
you want.

‘Formula by Example’ builds upon the technology that enables Flash Fill, 
leveraging logical-reasoning-based symbolic techniques to efficiently 
search for formulae that match the user-provided input and output 
examples.  It then ranks the formulae to pick one that likely matches the 
user’s intent – and if that’s not the case, the user can provide additional 
representative examples to guide the tool. 

‘Formula by Example’ is the next generation of the Flash Fill technology 
that covers a wider variety of transformations (including datetime and 
numeric manipulations) and generates readable Excel formulae.  This 
formula-by-example technology has recently also been released in Power 
Automate and Power Apps. 

You can now format your chart using the Home Ribbon Formatting controls in Excel for the web.

Support Chart Formatting via Selection and Ribbon Buttons
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You may now click and drag chart elements and the trend line equation to move them in a given chart in Excel for the web.  This expands users' ability 
to customise how their chart looks.

You may now create named ranges from the Name Box in Excel for the web.  Users may also search in the name box for any named ranges.

Move Chart Elements within Chart Player

Name Manager
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In Excel for Windows, you now have the ability in the Current and Monthly Enterprise channels to record repetitive spreadsheet tasks and turn them 
into replayable Office Scripts.   

Previously, you could create and modify automations using JavaScript and TypeScript using the Office Scripts Code Editor.  With the Action Recorder, 
you can automate repetitive worksheet tasks without needing any programming experience.

How it works:

	 1.	 Open any existing workbook

	 2.	 Select Automate -> Record Actions (Preview)

Also for Excel for Windows (Current Channel), ‘Get Data from Table/Range’ now includes Dynamic Arrays.  You simply select any Dynamic Array on 
the grid and import it using Power Query.

‘Rapid Refresh’ is a feature that automatically reloads the workbook in co-authoring scenarios where the user may be prompted to refresh manually.  
Multi-workbook support and support in Excel for Mac will be coming shortly.

In Excel for Windows previously, when co-authoring was interrupted for one reason or another, users would have to select ‘Save As’ (which creates 
another copy of the file) or else ‘Discard’ their changes to get back to the shared file.  With ‘Guided Reapply’, users may review the pending changes 
and return to the shared file as they wish.

	 3.	 Record actions in your workbook

	 4.	 When you’re done recording, click the Stop recording button in the ‘Record Actions (Preview)’ task pane to save the recorded actions into 	
	 	 a script that you can run at any time on any workbook.

Not all actions are recordable at this time.  Microsoft is continuing to add support to increase the number of recordable actions.  They encourage

you to continue trying to record actions useful to your workflow as that will help the team prioritise the order in which they add support.

To use Office Scripts, you must have the following:

	 •	 a stable internet connection

	 •	 a commercial (E3/E5) or Education Microsoft 365 subscription

	 •	 Microsoft Edge WebView2 installed. 

Office Scripts (Current Channel and Monthly Enterprise Channel)

Get data from Dynamic Arrays (Current Channel)

Rapid Refresh (Current Channel)

Guided Reapply (Current Channel)
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PivotTables allow you to easily create summaries, dashboards and 
reports, as well as aggregate information.  Whilst data types and in-cell 
images are a powerful part of modern Excel, PivotTables have only been 
able to use a text description of these modern content types.  Now, the 

images and data types come intact to your PivotTable rows and columns 
in both Excel for Windows and Excel for Mac.  They also include the same 
interactions you have in your source data (image cards, data type icons, 
data type cards, etc.).

To use it:

	 1.	 Create a PivotTable with images or data types in the source data

	 2.	 Add your fields with images or data types to the PivotTable rows or columns.

Use Image and Data Types in PivotTables (Insiders)
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You can also paste the examples into Excel using the IMAGE function.

This feature is available to Insiders who are running:

	 •	 Windows: Version 2307 (Build 16609.20000) or later

	 •	 Mac: Version 16.74 (Build 23060401) or later.

Dropdown lists are a handy way to make data entry and validation more 
efficient in Excel for Windows.  Microsoft has now added AutoComplete 
functionality, which automatically compares the text typed in a cell to all 

items in the dropdown list and displays only the items that match.  You 
should now be able to spend less time scrolling through lists, dealing with 
data validation errors or writing complex code to handle this task.  Yay!

Previously when you exported to PDF in Excel for Mac, there were 
no tags added to communicate the structure of the document so 
all of the content was jumbled together.  Now, the PDF service 
automatically creates accessibility tags, which brings the experience 
on par with Excel for Windows.

It’s common to copy text from a web page, an email or another document, and then paste it into Excel (for Windows).  Often, your goal is to match 
the format that is already in place in the cell or range where you’re pasting.  Until now, it was supposedly not possible to paste as plain text using 
shortcut keys (although I have been doing it using ALT + E + S + Arrow keys).

Likewise, when you copy a cell or range, and then want to paste values, you had a few options, but they all involved using multiple steps. You could:

	 •	 paste the copied content by pressing CTRL + V, and then select ‘Paste Values’ or ‘Match Destination Formatting’ in the ‘Paste Options’ 	
		  dialog box

	 •	 select ‘Paste Values’ or ‘Match Destination Formatting’ in the Paste drop-down menu in the Ribbon (ALT + H + V)
	 •	 press CTRL + ALT + V to open the ‘Paste Special’ dialog, choose Values or Text, and then press ENTER.

Now you can simply press CTRL + SHIFT + V!

Depending on what you copied, this will either paste with ‘Match Destination Formatting’ or it will paste values. 

This feature is rolling out to Beta Channel users running Version 2210 (Build 15726.20000) or later in Excel for Windows, and will be coming soon to 
Excel for Mac. 

Data Validation Dropdown List Autocomplete (Current Channel)

Generate an Accessible PDF 

Paste Values directly into your workbook using a Keyboard Shortcut (Current Channel)
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In Excel for Mac, the search experience has been revamped to provide a single place to find content from multiple sources.  This function provides 
smart search suggestions before you type as well as supporting searching for more than just text in your document, i.e. you can also search for 
commands, help articles or web results (such as definitions, media and search engine results).

The new experience: 

	 •	 provides smart search suggestions before you even type

	 •	 supports searching for more than just text in your document: you may also search for commands, help articles or web results

	 •	 makes the ‘Smart Lookup’ pane more accessible to people who are blind or have low vision with better support for VoiceOver as well as 	
		  improved keyboard navigation within groups.

To access it:

	 1.	 open an existing document, worksheet or presentation

	 2.	 click the Search box in the top-right corner of the app window, and select search suggestions

	 3.	 in the Search box, type a keyword or phrase you want to find in the document, worksheet or presentation

	 4.	 to search for a command, type the command name in the Search box

	 5.	 to search in the document, click ‘Find in this document’, and then enter the word or words you want to find

Enhanced Search Experience 
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	 6.	 to look for web or media results, click the ‘Open Search’ pane, or right-click anywhere on the document, worksheet or presentation, and 	
	 	 then click the ‘Open Search’ pane in the shortcut menu.

If you prefer to use your keyboard, use the shortcuts to access the enhanced search experience:

Command Shortcut

‘Open Search’ dropdown CMD + CTRL + U

Find in document CMD + F

‘Open Search’ pane CMD + CTRL + L
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It should be noted that the Search drop-down menu does not close when you click the Ribbon tabs.

This feature is available to Beta Channel users who are running Version 16.74 (Build 23043001) or later, or to any users who have a Microsoft Office 
2021 license.

The updated version of the grid with all the new features is fast becoming too complicated to show clearly here.  Nonetheless, you can find the 
interactive links at aka.ms/ExcelFeaturesFlyer. 
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More next month, we’re sure.

Sometimes, you wish to forecast what comes next in a sequence, i.e. make a forecast.  There are various approaches you could use:

	 •	 Naïve method: this really does live up to its billing – you simply use the last number in the sequence, e.g. the continuation of the series 8, 	
		  17, 13, 15, 19, 14, … would be 14, 14, 14, 14, …  Hmm, great

	 •	 Simple average: only a slightly better idea: here, you use the average of the historical series, e.g. for the continuation of the series 8, 17, 	
		  13, 15, 19, 14, … would be 14.3, 14.3, 14.3, 14.3, …  

	 •	 Moving average: now we start to look at smoothing out the trends by taking the average of the last n items.  For example, if n were 3, 	
		  then the sequence continuation of 8, 17, 13, 15, 19, 14, … would be 16, 16.3, 15.4, 15.9, 15.9, …

	 •	 Weighted moving average: the criticism of the moving average is that older periods carry as much weighting as more recent periods, 	
		  which is often not the case.  Therefore, a weighted moving average is a moving average where within the sliding window values are given 	
		  different weights, typically so that more recent points matter more.  For example, instead of selecting a window size, it requires a list of 	
		  weights (which should add up to 1).  As an illustration, if we picked four periods and [0.1, 0.2, 0.3, 0.4] as weights, we would be giving 10%, 	
		  20%, 30% and 40% to the last 4 points respectively which would add up to 1 (which is what it would need to do to compute the average

		  Therefore the continuation of the series 8, 17, 13, 15, 19, 14, … would be 15.6, 15.7, 15.7, 15.5, 15.6, …

	 •	 Regression analysis: this is a technique where you plot an independent variable on the x (horizontal axis) against a dependent variable on 	
		  the y (vertical) axis.  “Independent” means a variable you may select (e.g. “June”, “Product A”) and dependent means the result of that 	
		  choice or selection.

For example, if you plotted your observable data on a chart, it might look something like this:

The A to Z of Excel Functions: LOGEST
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For example, if you plotted your observable data on a chart, it might look something like this:

There is a statistical technique where you may actually draw the “best straight line” through the data using an approach such as Ordinary 
Least Squares.  Once you have worked it out, you can calculate the gradient (m) and where the line cuts the y axis (the y intercept, c).  This 
gives you the equation of a straight line:

y = mx + c

Therefore, for any independent value x, the dependent value y may be calculated – and we can use this formula for forecasting.  Of course, 
this technique looks for a straight line and is known as linear regression

The line may be defined by

y = bmx

or in more complex situations,

y = bm1
x1m2

x2…

if there are multiple x-values, where the dependent y-value is a function of the independent x-values.  The m-values are bases corresponding to each 
exponent x-value, and b is a constant value. Note that y, x and m can be vectors.  The array that LOGEST returns is {mn, mn-1, ..., m1, b}.

The LOGEST function employs the following syntax to operate:

LOGEST(known_y’s, [known_x’s], [constant], [statistics]).

	 •	 Exponential curve fitting: if the relationship is not linear, a more suitable approach may be to calculate the best fit exponential curve:
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The LOGEST function has the following arguments:

	 •	 known_y’s: this is required and represents the set of y-values that you already know in the relationship y = bmx (nothing to do with bicycles)

	 •	 known_x’s: this is optional and denotes the set of x-values that you may already know in the relationship y = bmx

	 •	 constant: this argument is optional and is a logical value specifying whether to force the constant b to equal one (1)
	 •	 statistics: this final argument is also optional.  This too is a logical value specifying whether to return additional regression statistics  
		  (see below).

It should be further noted that:

	 •	 if the range of known_y's is either in a single column or else a single row, each column of known_x's is interpreted as a separate variable
	 •	 the range of known_x's may include one or more sets of variables.  If only one variable is used, known_y's and known_x's can be ranges 	
		  of any shape, as long as they have equal dimensions.  If more than one variable is used, known_y's must be a vector (i.e. a range with a 	
		  height of one row or a width of one column)

	 •	 if known_x's is omitted, it is assumed to be the array {1,2,3,...} that is the same size as known_y's
	 •	 if constant is TRUE or omitted, b is calculated normally

	 •	 if constant is FALSE, b is set equal to one (1) and the m-values are adjusted to fit y = mx

	 •	 if statistics is TRUE, LOGEST returns the additional regression statistics; as a result, the returned array is {mn, mn-1, ..., m1, c; sen, sen-1, ..., 	
		  se1, sec; r

2, sey; F, df; ssreg, ssresid}
	 •	 if statistics is FALSE or omitted, LOGEST returns only the m-coefficients and the constant b.

With regard to the additional regression statistics, these are produced in a grid (an array) as follows:

These statistics may be described as follows:

Statistic Description
 

se1, se2, …, sen

 
Standard error values for the coefficients m1, m2, …, mn.

The standard error is a measure of the statistical accuracy of an estimate, equal to the standard 
deviation of the theoretical distribution of a large population of such estimates.  It is usually 
estimated in practice as the sample standard deviation divided by the square root of the sample 
size (assuming statistical independence of the values in the sample),  

seb Standard error value for the constant c (but this is equal to #N/A when constant is FALSE

r2 This the coefficient of determination, which compares estimated and actual y-values and ranges, 
with a value between zero(0) and one (1).  If it is 1, there is a perfect correlation in the sample, 
i.e. there is no difference between the estimated y-value and the actual y-value.  At the other 
extreme, if the coefficient of determination is zero, the regression equation is not helpful in 
predicting a y-value.

The coefficient of determination, R2, is the proportion of the variance in the dependent variable 
that is predictable from the independent variable(s).  There are several definitions of R2, but they 
are not always equivalent (indeed, they can be negative on ocassion).  One class of such cases 
includes that of simple linear regression where r2 is used instead of R2.  When an intercept is 
included, then r2 is simply the square of the sample correlation coefficient (i.e. r) between the 
observed outcomes and the observed predictor values.  Here, the coefficient of determination 
will range between zero (0) and one (1)
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Statistic Description

sey

 
Standard error for the y estimate

F This is the F statistic or the F-observed value.  You should use the F statistic to determine whether 
the observed relationship between the dependent and independent variables occurs by chance

This may be calculated using the F.INV.RT function in Excel.  An F statistic is a value you get when 
you run an analysis of variance (ANOVA) test or a regression analysis to find out if the means 
between two populations are significantly different.  It’s similar to a T statistic from a T-Test: a 
T-test will tell you if a single variable is statistically significant, whereas an F test will tell you if a 
group of variables are jointly significant

df The degrees of freedom.  You should use the degrees of freedom to help you find F-critical values 
in a statistical table.  Compare the values you find in the table to the F statistic returned by 
LOGEST to determine a confidence level for the model.

The degree(s) of freedom is the number of independent values or quantities which may be 
assigned to a statistical distribution.  It is is calculated as follows.

When no x columns are removed from the model due to collinearity:

	 •	 if there are k columns of known_x’s and constant = TRUE or is omitted, df = n – k – 1
	 •	 if constant = FALSE, df = n - k.

In both cases, each x column that is removed due to collinearity increases the value of df by one (1)

ssreg This is the regression sum of squares

In regression analysis, Excel calculates for each point the squared difference between the y-value 
estimated for that point and its actual y-value.  The sum of these squared differences is called 
the residual sum of squares, ssresid.  Excel then calculates the total sum of squares, sstotal.  When 
the constant argument = TRUE or is omitted, the total sum of squares is the sum of the squared 
differences between the actual y-values and the average of the y-values.  When the constant 
argument = FALSE, the total sum of squares is the sum of the squares of the actual y-values 
(without subtracting the average y-value from each individual y-value).  Then, the regression 
sum of squares, ssreg, may be found from: ssreg = sstotal - ssresid.  The smaller the residual sum 
of squares is, compared with the total sum of squares, the larger the value of the coefficient of 
determination, r2, which is an indicator of how well the equation resulting from the regression 
analysis explains the relationship among the variables.  The value of r2 equals ssreg/sstotal

ssresid This is the residual sum of squares, as explained above.

To be clear:

	 •	 the more a plot of your data resembles an exponential curve, the better the calculated line will fit your data.  Like LINEST, LOGEST returns 	
	 an array of values that describes a relationship among the values, but LINEST fits a straight line to your data; LOGEST fits an exponential curve

	 •	 when you have only one independent x-variable, you can obtain y-intercept (b) values directly by using the following formula: 

y-intercept (b): INDEX(LOGEST(known_y's, known_x's), 2)

	 •	 you can use the y = bmx equation to predict future values of y, but Excel has a GROWTH function to do this for you

	 •	 when entering an array constant such as known_x's as an argument, use commas to separate values in the same row and semicolons to 	
	 separate rows.  Separator characters may be different depending upon your regional settings

	 •	 you should note that the y-values predicted by the regression equation may not be valid if they are outside the range of y-values you 	
	 used to determine the equation.
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A Lognormal distribution is a statistical distribution of logarithmic values 
from an underlying Normal distribution.  A Lognormal distribution may 
be translated to a Normal distribution and vice versa using the associated 
logarithmic translations.

A Normal distribution is a symmetrical probability distribution of 
outcomes that forms a bell curve.  In a Normal distribution, 68% of 
the results fall within one standard deviation and 95% fall within two 
standard deviations, viz.

The A to Z of Excel Functions: LOGINV

Please see our comprehensive example below: 
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While most people are familiar with a Normal distribution, they may 
not be as familiar with the related Lognormal distribution.  A Normal 
distribution may be converted to a Lognormal distribution using 
logarithms.  It should be noted that Lognormal distributions can only 
arise from a Normally distributed set of random variables.

There can be a few reasons for using Lognormal distributions in 
conjunction with Normal distributions.  Most commonly, Lognormal 
distributions are the result of taking the natural logarithm where the 
base is equal to e=2.718...  However, the Lognormal distribution may be 
scaled using a different base, if desired, which affects the shape of the 
Lognormal distribution.

The Lognormal distribution plots the logarithm of random variables from 
a Normal distribution curve.  In general, the logarithm is known as the 
exponent to which a base number must be raised in order to produce the 
random variable (x) that is found along a Normally distributed curve.  It 
should be noted that Lognormal distributions are positively skewed with 
long right tails due to low mean values and high variances in the random 
variables.

Clear as mud, yes?

In practice, Normal distributions may present a few problems that 
Lognormal distributions can solve.  In particular, Normal distributions 
allow for negative random variables whilst Lognormal distributions 
include all positive variables.

Probably (get it?) the most common application where Lognormal 
distributions are used in finance is in the analysis of stock prices.  A 
Lognormal distribution is more suitable for this purpose because asset 
prices cannot be negative.  An important point to note is that when 
the continuously compounded returns of a stock follow a Normal 
distribution, then the stock prices follow a Lognormal distribution.  The 
Lognormal distribution curve may therefore be used to help better 
identify the compound return that the stock can expect to achieve over 
a period of time.

The distribution is occasionally referred to as the Galton distribution or 
Galton's distribution, after Francis Galton.  In summary, a Lognormal 
process is “simply” the statistical realisation of the multiplicative product 
of many independent random variables, each of which is positive and it 
is therefore the maximum entropy probability distribution for a random 
variate x for which the mean and variance of LN(x) are specified.  And if 
you follow all of that, get out of here because no one likes a smartarse.  

The LOGINV function returns the inverse of the Lognormal cumulative distribution function of x, where LN(x) is Normally distributed with parameters 
mean and standard_deviation.  

If p = LOGNORMDIST(x, …) then LOGINV(p, …) = x.  It’s confusing, as you might think LOGINV = EXP!
The LOGINV  function employs the following syntax to operate:

LOGINV(probability, mean, standard_deviation)

The LOGINV function has the following arguments:

	 •	 probability: this is required and represents a probability associated with the Lognormal distribution

	 •	 mean: this is also required and denotes the mean of the natural logarithm of x, LN(x)
	 •	 standard_deviation: again required, this is the standard deviation of LN(x).

It should be noted that:

	 •	 this function has been replaced by LOGNORM.INV.  Microsoft states that the new function may provide improved accuracy, as well as 	
		  provide a function name that better reflects its usage

	 •	 although this function is still available for backward compatibility, consider using LOGNORM.INV from now on, because this function may 	
		  not be available in future versions of Excel

	 •	 if any argument is nonnumeric, LOGINV returns the #VALUE! error value
	 •	 if probability ≤ 0 or probability ≥ 1, LOGINV returns the #NUM! error value
	 •	 if x ≤ 0 or if standard_deviation ≤ 0, LOGINV returns the #NUM! error value
	 •	 the inverse of the lognormal distribution function is given by

		  LOGINV(p, μ, σ) = e[μ + σx(NORMSINV(p))]

Please see the example below: 
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The A to Z of Excel Functions: LOGNORM.DIST

The LOGNORM.DIST function returns the Lognormal distribution of x, where LN(x) is Normally distributed with parameters mean and standard_
deviation.  The LOGNORM.DIST  function employs the following syntax to operate:

LOGNORM.DIST(x, mean, standard_deviation, cumulative)

The LOGNORM.DIST function has the following arguments:

	 •	 x: this is required and represents the value at which to evaluate the function
	 •	 mean: this is also required and denotes the mean of the natural logarithm of x, LN(x)
	 •	 standard_deviation: again required, this is the standard deviation of LN(x)
	 •	 cumulative: yet again, this final argument is required.  This is a logical value that determines the form of the function.  If cumulative is 	
		  TRUE, LOGNORM.DIST returns the cumulative distribution function; if FALSE, it returns the probability density function.

It should be noted that:

	 •	 if any argument is nonnumeric, LOGNORM.DIST returns the #VALUE! error value
	 •	 if x ≤ 0 or if standard_deviation ≤ 0, LOGNORM.DIST returns the #NUM! error value
	 •	 the equation for the lognormal cumulative distribution function is: 

Please see our comprehensive example below: 
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The A to Z of Excel Functions: LOGNORM.INV

The LOGNORM.INV function returns the inverse of the Lognormal cumulative distribution function of x, where LN(x) is Normally distributed with 
parameters mean and standard_deviation.  

If p = LOGNORM.DIST(x, …) then LOGNORM.INV(p, …) = x.

The LOGNORM.INV  function employs the following syntax to operate:

LOGNORM.INV(probability, mean, standard_deviation)

The LOGNORM.INV function has the following arguments:

	 •	 probability: this is required and represents a probability associated with the Lognormal distribution

	 •	 mean: this is also required and denotes the mean of the natural logarithm of x, LN(x)
	 •	 standard_deviation: again required, this is the standard deviation of LN(x).

It should be noted that:

	 •	 this function has replaces LOGINV.  Microsoft states that this new function may provide improved accuracy, as well as provide a function  
		  name that better reflects its usage

	 •	 although LOGINV is still available for backward compatibility, consider using LOGNORM.INV from now on, because the former function  
		  may not be available in future versions of Excel

	 •	 if any argument is nonnumeric, LOGNORM.INV returns the #VALUE! error value
	 •	 if probability ≤ 0 or probability ≥ 1, LOGNORM.INV returns the #NUM! error value
	 •	 if x ≤ 0 or if standard_deviation ≤ 0, LOGNORM.INV returns the #NUM! error value.

Please see our comprehensive example below: 

The LOGNORM.INV function returns the inverse of the Lognormal cumulative distribution function of x, where LN(x) is Normally distributed with 
parameters mean and standard_deviation.  

If p = LOGNORM.DIST(x, …) then LOGNORM.INV(p, …) = x.

The LOGNORM.INV  function employs the following syntax to operate:

LOGNORM.INV(probability, mean, standard_deviation)
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The LOGNORM.INV function has the following arguments:

	 •	 probability: this is required and represents a probability associated with the Lognormal distribution

	 •	 mean: this is also required and denotes the mean of the natural logarithm of x, LN(x)
	 •	 standard_deviation: again required, this is the standard deviation of LN(x).

It should be noted that:

	 •	 this function has replaces LOGINV.  Microsoft states that this new function may provide improved accuracy, as well as provide a function 	
		  name that better reflects its usage

	 •	 although LOGINV is still available for backward compatibility, consider using LOGNORM.INV from now on, because the former function 	
		  may not be available in future versions of Excel

	 •	 if any argument is nonnumeric, LOGNORM.INV returns the #VALUE! error value
	 •	 if probability ≤ 0 or probability ≥ 1, LOGNORM.INV returns the #NUM! error value
	 •	 if x ≤ 0 or if standard_deviation ≤ 0, LOGNORM.INV returns the #NUM! error value.

Please see the example below: 

The LOGNORMDIST function returns the Lognormal distribution of x, where LN(x) is Normally distributed with parameters mean and standard_
deviation.  The LOGNORMDIST  function employs the following syntax to operate:

LOGNORMDIST(x, mean, standard_deviation)

The LOGNORMDIST function has the following arguments:

		 •	 x: this is required and represents the value at which to evaluate the function
		 •	 mean: this is also required and denotes the mean of the natural logarithm of x, LN(x)
		 •	 standard_deviation: again required, this is the standard deviation of LN(x).

It should be noted that:

		 •	 if any argument is nonnumeric, LOGNORMDIST returns the #VALUE! error value
		 •	 if x ≤ 0 or if standard_deviation ≤ 0, LOGNORMDIST returns the #NUM! error value
		 •	 the equation for the lognormal cumulative distribution function is:

The A to Z of Excel Functions: LOGNORMDIST
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		 •	 This function has been replaced with a new function (LOGNORM.DIST) that may provide improved accuracy and whose names better 	
		 	 reflect their usage.  Although this function is still available for backward compatibility, you should consider using the new functions from 	
		 	 now on, because this function may not be available in future versions of Excel.

Please see our final example for this month below:

More Excel Functions next month.

To recap, this month’s challenge was to create multiple worksheets from a data list.  The intention was to dynamically create the worksheets without 
manual intervention.  Essentially, we wanted to generate multiple worksheets with the names from the data list shown below:

to become:

Beat the Boredom Suggested Solution

One simple way here is to use VBA to look through the 
value of each cell in the data list and assign the value to 
each worksheet created after the ‘Summary’ worksheet 
(i.e. the sheet with the list).  The first step is to set up a 
named range as shown below.  Here, we will define the 
cell range A2:A13 as the data list and assign a name tag 
Source to this range as shown below.

Suggested Solution
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The next step is to declare the relevant variables.

Dim wksht As Worksheet

Dim rng As Range

Dim sName As String

Then, we set the variable wksht as the active worksheet and turn off the ScreenUpdating application.  If the ScreenUpdating property were set to 
False, it will speed up the macro operation.

Set wksht =ActiveSheet

Application.ScreenUpdating = False

Next, we use a ‘For Loop’ to look up each value in the named range and assign the range value to the string variable sName.  Then, we use an ‘If’ 
statement to determine the length of the variable sName.  If the length is greater than zero, then we add a new worksheet after the last page and 
set the worksheet name equal to the value stored in variable sName, viz.

For Each rng In Range("Source")

sName = rng.Value

If Len(sName) > 0 Then

Worksheets.Add after:=Worksheets(Worksheets.Count)

ActiveSheet.Name = sName

End If

Next rng

Next, we go back to the Summary worksheet and turn on the ScreenUpdating application once more. 

Worksheets("Summary").Select

Application.ScreenUpdating = True

Combing all the lines of code together, we get this:

Sub AddWorksheetsFromSelection()

    Dim wksht As Worksheet

    Dim rng As Range

    Dim sName As String

    Set wksht = ActiveSheet

    Application.ScreenUpdating = False

    For Each rng In Range("Source")

          sName = rng.Value

        If Len(sName) > 0 Then

                Worksheets.Add after:=Worksheets(Worksheets.Count)

                ActiveSheet.Name = sName

        End If

     Next rng

    Worksheets("Summary").Select

    Application.ScreenUpdating = True

End Sub

By using this method, we could create multiple worksheets from the named range without repetitive manual intervention.

Until next month.
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Link to Others
These newsletters are not intended to be 
closely guarded secrets.  Please feel free 
to forward this newsletter to anyone you 
think might be interested in converting to 

“the SumProduct way”.

If you have received a forwarded 
newsletter and would like to receive 
future editions automatically, please 

subscribe by completing our newsletter 
registration process found at the foot of 
any www.sumproduct.com web page.

Any Questions?
If you have any tips, comments or queries 
for future newsletters, we’d be delighted 
to hear from you. Please drop us a line at 

newsletter@sumproduct.com.

Our Services
We have undertaken a vast array of 
assignments over the years, including:
· 	 Business planning
· 	 Building three-way integrated 		
	 financial statement projections
· 	 Independent expert reviews
· 	 Key driver analysis
· 	 Model reviews / audits for internal 	 	
	 and external purposes
· 	 M&A work
· 	 Model scoping
· 	 Power BI, Power Query & Power Pivot
· 	 Project finance
· 	 Real options analysis
· 	 Refinancing / restructuring
· 	 Strategic modelling
· 	 Valuations
· 	 Working capital management
If you require modelling assistance of any 
kind, please do not hesitate to contact us 
at contact@sumproduct.com.

Training
SumProduct offers a wide range of 
training courses, aimed at finance 
professionals and budding Excel experts. 
Courses include Excel Tricks & Tips, 
Financial Modelling 101, Introduction to 
Forecasting and M&A Modelling. 

Drop us a line at training@sumproduct.com 
for a copy of the brochure or download  
it directly from 
www.sumproduct.com/training.

Check out our 
more popular 
courses in 
our training 
brochure:

Key Strokes
Each newsletter, we’d like to introduce you to useful keystrokes you may or may not be aware of.  We’ve started going through the 
alphabet actions.  We earn a D this month…

Keystroke What it does
CTRL + Decimal Rotates the active cell through the corners of the selection
Delete Clear
CTRL + Delete Clear
SHIFT + Delete Cut
CTRL + Divide (/) Select array
Down Arrow Move down one cell
ALT + Down Arrow Open dropdown (AutoComplete, Filter or Validation)
CTRL + Down Arrow Select the last cell in the area down
CTRL + ALT + Down Arrow Intel chipset: invert screen (turn 180 degrees)
CTRL + SHIFT + Down Arrow Extend selection down to last cell in area down
SHIFT + Down Arrow Extend selection down one cell

There are c.550 keyboard shortcuts in Excel.  For a comprehensive list, please download our Excel file at
www.sumproduct.com/thought/keyboard-shortcuts. Also, check out our new daily Excel Tip of the Day feature on the 
www.sumproduct.com homepage.
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Location Course Date Date Duration Duration

Online (Australia) Power Pivot, Power Query and Power BI 15 - 17 Aug 2023 09:00-17:00 AEST (-1 day) 23:00-17:00 GMT 3 Days

Online (Australia) Excel Tips and Tricks 11 Sep 2023 09:00-17:00 AEST (-1 day) 23:00-17:00 GMT 1 Day

Online (Australia) Financial Modelling 12 - 13 Sep 2023 09:00-17:00 AEST (-1 day) 23:00-17:00 GMT 2 Days

Online (Australia) Power Pivot, Power Query and Power BI 22 - 24 Nov 2023 09:00-17:00 AEDT (-1 day) 22:00-17:00 GMT 3 Days

Online (Australia) Excel Tips and Tricks 5 Dec 2023 09:00-17:00 AEDT (-1 day) 22:00-17:00 GMT 1 Day

Online (Australia) Financial Modelling 6 - 7 Dec 2023 09:00-17:00 AEDT (-1 day) 22:00-17:00 GMT 2 Days

Upcoming SumProduct Training Courses - COVID-19 update
Due to the COVID-19 pandemic that is currently spreading around 
the globe, we are suspending our in-person courses until further 
notice.  However, to accommodate the new working-from-home 
dynamic, we are switching our public and in-house courses to 
an online delivery stream, presented via Microsoft Teams, with 
a live presenter running through the same course material, 
downloadable workbooks to complete the hands-on exercises 
during the training session, and a recording of the sessions for 

your use within 1 month for you to refer back to in the event 
of technical difficulties.  To assist with the pacing and flow of 
the course, we will also have a moderator who will help answer 
questions during the course.

If you're still not sure how this will work, please contact us at 
training@sumproduct.com and we'll be happy to walk you 
through the process.
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